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PanelBuilder Import Tool 

SoftPLC Corporation introduces the PanelBuilder Import Tool — a powerful, flexible, easy-to-
use tool that expands the capabilities of your installed plant-floor systems. You can use the Tool 
to import applications created with PanelBuilder (Allen-Bradley’s programmer for PanelView 
Human Machine Interfaces (HMIs)) into SoftPLC Web Studio (SWS) using a fast and intuitive 
wizard.  

Using the Import Tool  to Import PanelBuilder Applications to SoftPLC Web Studio
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After importing an application into Web Studio, you can take advantage of the these Web Studio 
features: 

 Flexibility:  Web Studio can run the application on any Microsoft® Windows®  platform 

(NT/2000/XP/Vista/7/8/10, Embedded or CE). 

 Expansibility: You can use the  development suite to add functionality to your application 

(historical data, XML reports, math scripts, and so forth). 

 Connectivity: Because the application is now running under the Web Studio runtime, you 

can take advantage of all connectivity tools embedded in the Web Studio package, such as: 

• Communication drivers for several protocols from different manufacturers (Modbus, 
Profibus, DeviceNET, Siemens S7 – MPI/PP, GE-Fanuc SNP/SRTP and many others) 

• OPC Client and Server interfaces 

• XML and ADO interfaces to exchange data with third-party systems, such as Enterprise 
Resource Planning (ERP) systems 

• API Toolkits to integrate the application with third-party programs written in any language 
that supports DLLs (VB, C, C++, and so forth). 

• TCP/IP modules for redundant and networked applications 

• Thin Client solution that provides remote access to your application using just a Web 
Browser, through any TCP/IP link (intranet, Internet, or dial-up connection) 

• Remote management and debugging tools that allow you to manage (download, upload, 
run, stop, and debug) your application remotely from a development station. 

The Import Tool’s greatest advantage is how easy it is to use — which can dramatically reduce 
the cost and hassle of modernizing the automation systems in your facility. 
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Import Requirements 

To import a PanelBuilder application you must install the following software on your computer: 

Web Studio v6.0+SP1 (or higher) 
PanelBuilder32 programming software 
PanelBuilder application file (.pba file) 

Import Procedures 

The  Import Tool provides a simple, straightforward wizard to guide you through the process of 
importing PanelBuilder projects into Web Studio. This import process consists of three steps:  

1. Installing a Generic / Text only printer 

Note:  To generate a PanelBuilder application report, you must use the Generic/Text only printer 
provided with your computer operating system. If you already have this printer installed on your 
system, you can skip step 1. 

2. Generating a PanelBuilder application report  

3. Importing the application using Web Studio Import Wizard 

Step 1 – Installing the Generic / Text Only Printer 

To install the Generic / Text only printer that comes with your operating system, follow  these 
steps: 

1. Click the Windows Start button and then select Settings → Printers. 

2. In the Printers window, double-click the Add Printer icon to start the Add Printer wizard. 

3. When the wizard Welcome screen displays, click Next to open the Local or Network Printer 
screen.  

4.  Click (enable) the Local Printer radio button and clear (disable) the Automatically detect 
and install my Plug and Play printer check box. Click Next to continue to the next screen. 
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Local or Network Printer Screen 

5. When the Select the Printer Port screen displays, select FILE: Print to File from the list of 
Ports, and then click Next. 

Selecting the Printer Port 
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6. On the Add Printer Wizard screen, select  Generic from the Manufacturers list and select 
Generic / Text Only from the Printers list. Click Next to continue.

Adding a Generic Printer Wizard 

The Wizard will take you to three more screens, as follows:  

• Name Your Printer: Allows you to specify a name for the printer and make it your default. 

• Printer Sharing: Allows you to share this printer. 

• Print Test Page: Allows you to confirm the printer installed correctly by printing a test page. 

1. You can change any of the default parameters and then click Next to progress through the 
screens, or simply accept the default settings on each screen by clicking Next. 

2.  When the Completing the Add Printer Wizard screen displays, verify the information 
displayed and if there are no changes, click Finish. 

Final Screen 

Now  you  are  finished  installing  the  printer.  Continue  to  the  next  section  and  follow  the 
instructions for generating the PanelBuilder application report. 

Web Studio PanelBuilder Import Tool Page 5



Step 2 – Generating a PanelBuilder Application Report  

This section explains how  to generate a PanelBuilder application report. 

1. After you install the Generic / Text only printer, open your PanelBuilder application to 
generate the report.  

2.  Select Tools → Options from the PanelBuilder menu bar, and when the Options dialog box 
displays, select the Report Setup tab. 

3. Click (enable) only the options shown in the following figure and then click OK. 

Options Dialog

4. Select File → Reports from the PanelBuilder menu bar. 

5.  When the Print Reports dialog displays, click the Printer Setup button. 

Print Reports Dialog 
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6. When the Print Setup dialog displays, click the Name combo-box button and select Generic 
/ Text only from the list.  

Selecting the Printer 

7. In the Paper section, click the Size combo-box button and select the A3 paper size. 

Selecting the Paper Size 

Web Studio PanelBuilder Import Tool Page 7



8. In the Orientation section, click Landscape, and then click OK. 

Selecting the Paper Orientation 

9. When the Print Reports dialog displays again, clear (disable) the Screen Images check box 
and then click the Print button.  

Clearing the Screen Images Check Box 

10. When the Print to File dialog displays, enter a file name and location for the report, and then 
click OK. 

Specifying a File Name 

PanelBuilder will save the resulting file to the designated location. Now you can import this file 
into  Web Studio, continue to the next section for instructions. 
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Step 3 – Importing the Application Using Web Studio 
After generating the application report, you can import the information from that report into SWS 
and automatically create a new SWS application with the same characteristics as your original 
PanelBuilder application.  

Use the following procedure to import the PanelBuilder application report into SWS: 

1. Start  Web Studio by selecting Start → Programs  →  Web Studio  →  Web Studio. 

2. Select File → Import Wizard (see figure) to open the  Import Tool Wizard. 

Opening the Import Wizard 

Note:  You can use the SWS Import Wizard to import application data from sources other than 
PanelBuilder applications. For more information about importing other application types, refer to 
the Web Studio Users Guide and Technical Reference. 

3. When the Import Wizard dialog box displays (see figure), select PanelBuilder Application 
from the Source Type list, and then click Next. 

Selecting the Application to Import  
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The Import PanelView Application Wizard dialog box displays (as follows).  

Import PanelBuilder Application Wizard 

4. Use this dialog to specify the following import parameters, and then click Next.: 

• Do not import duplicate tags radio button: Click (enable) this option to prevent the Import 
PanelBuilder Application Wizard from importing tags with the same name as tags in the current 
SWS application database. 

• Replace duplicates with tags imported radio button: Click (enable) this option if you want 
the Import PanelBuilder Application Wizard to replace duplicate tag properties in the current 
SWS application database. 

• Use prefix check box: Click (enable) this option if you want to add a prefix to all imported 
tags. Because you can import multiple PanelBuilder applications into a single SWS application, 
this feature is provided to help you identify where the imported application tags originated and 
avoid duplications. Simply type a prefix into the text field. 

• Import Screens check box and text field: Clear (disable) this option to prevent the Import 
PanelBuilder Application Wizard from importing the PanelBuilder application screens. 

• Import Comm. Configuration check box: Clear (disable) this option to prevent the Import 
PanelBuilder Application Wizard from importing the communication properties configured for 
each tag in the PanelBuilder application. 

• Report File text field: Type the name of the PanelBuilder report file you generated earlier.
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The Import PanelBuilder Application Wizard will read the report file and then display a new 
dialog box listing all the tags in the report file (similar to the following figure).  

List of Tags in the Report File 

The tags are color-coded to indicate which tags will be imported: 

• Blue tags will be imported. (If you do not want to import one of these tags, simply clear 
(disable) the check box to the left of the tag name.) 

• Red tags will not be imported. (If you enabled the Do not import duplicate tags option, the 
Import PanelBuilder Application Wizard will not import tags that already exist in the SWS 
application database.)  

• Gray tags can be imported. Tags become gray in two circumstances: 

(a) You cleared (disabled) the check box to the left of an importable (blue) tag, which changes 
the blue tag to gray. 

(b) You have met, or exceeded, the number of tags allowed by your  Web Studio license. For 
example, if your license allows 1,500 tags, and you would exceed this limit by importing the grey 
tags, SWS will not allow the Import PanelBuilder Application Wizard to add these tags to the 
SWS database. 

You can import gray tags (by enabling the check box to the left of the tag name), as long as you 
do not exceed the number of tags allowed by your SWS license.  

5. Click the Finish button to import the application according to the import parameters you 
specified in the previous step.  

Note:  If your application uses bitmaps (.bmp) other than those in the standard PanelBuilder list, 
export the bitmap file and copy it to the < Web Studio Installation Folder>\Lib folder. 
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Release Notes 

The  Import Tool is still going through the development process.  This first release implements 
the most important features.  The next list illustrates all the features that are not imported 
automatically.  Because Web Studio is much more powerful than PanelBuilder is, it is possible to 
workaround the items that are not imported by implementing some minor changes in the 
application.  If your application uses one of the features that you the import wizard does not 
import and you think that you will spend a lot of time implementing this feature on your 
application, please contact your representative or send an e-mail to support@softplc.com and 
we will analyze the possibility of implementing that specific feature. 

Graphical Interface 

The graphical tools offered by Web Studio overcome the expectations when compared with the 
other tools available in the market.  When importing the application using the Import Wizard, you 
will realize that the imported graphical interface will look even better than the original one.

 However, some features available in other products are very different from the way that Web 
Studio implements;  development philosophy is to implement Windows standards and use 
simple to use controls, that is why the product is so easy to use and you can develop good 
looking screens in a few minutes.  During our development research we realized that some 
features available in the PanelBuilder are so “unusual” that most of the applications do not use 
them. These features are not being imported, only because most of the applications that we 
tested against did not use them. The following properties, unless they are explicitly declared in 
the graphical compatibility list (see next topic), are not imported by the import wizard: Shape, Fill 
Pattern, Graphic, Line Type and Print. 

This section has the objects supported by PanelBuilder and also mentions the properties that 
are not supported by the Import Wizard.  Items marked in RED are features that we found in 
some of the applications that we test against and that will probably be implemented for next 
releases.  Items marked in YELLOW are minor items that do not make much difference in the 
graphical interface and they will not be implemented unless there is a strong reason to do so. If 
there is any property associated with an object that you could not find in this list it means that 
the property is not being imported and that you should contact your SoftPLC representative or 
send an e-mail to support@softplc.com with the information about the specific property. 
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PB Object: Pushbutton – Momentary, Maintained and Latched 

SWS Object: Pushbutton 

Write Tag Tag / Exp 

Hold Time Not Supported

Indicator/Display Tag Indicator

Handshake Tag Reset

Data Type/Format Not Supported

Contact Type State

Initial State Not Supported

 States:

Number
0 -  Open / 1 – Closed / Error – Aditional Pushbutton with 
Position 

Blink Blink set to slow 

Value Value

FG Color Not Supported 

BG Color Color

Text Properties
All the properties are supported, but they need to be the 
same for all states.

PB Object: Screen Selector – Goto 

SWS Object: Button with command dynamic (Open Function) 

Text Properties All the text properties are supported

FG Color Not Supported

BG Color Button Fill Color

Destination Screen
Parameter passed to open function in the button 
command

PB Object: Screen Selector - Return 

SWS Object: Button with command dynamic (OpenPrevious Function) 

Text Properties All the text properties are supported

FG Color Not Supported

BG Color Button Fill Color

Blink Position Dynamic associated with the object
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PB Object: Screen Selector - Goto Config Screen

SWS Object: Config Screen is not supported

PB Object: Screen Selector - Screen List Selector  

SWS Object: List Box + Button with command dynamic (Open Function) 

Wrap List List Box List Wrap Option 

FG Color List Box Border

BG Color List Box Window Color

Fix Cursor at State Not Supported

Text Properties
Wrap is the only text property not supported.  The font 
size and background color will be the same for all the 
items in the screen list.

PB Object: Numeric Entry – Cursor Point  

SWS Object: Rectangle with command dynamic + 
Text I/O with keypad enabled 

Text Properties Text I/O Properties 

FG Color Rectangle Liner Color

BG Color Rectangle Fill Color 

Write Tag
Text I/O Expression and Keypad function call in the 
command dynamic

Indicator/Display Tag Not Supported

Notification Tag Not Supported

Handshake Tag Not Supported

Decimal Point Format Function in the Text I/O Expression

Blink Position Dynamic associated with the object 

PB Object: Numeric Entry – Inc/Dec  

SWS Object: Not Supported
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PB Object: Numeric Entry – Keypad Enable 

SWS Object: Rectangle + Command Dynamic to open the Keypad +
Rectangle with caption

Text Properties Rectangle caption properties

FG Color Rectangle Liner Color

BG Color Rectangle Fill Color 

Write Tag Used in the command that activates the Keypad

Indicator/Display Tag Used in the rectangle caption

Notification Tag Not Supported

Handshake Tag Not Supported

Decimal Point Format Function in the Rectangle Caption

PB Object: Control List Selector (Standard and Piloted) & Indicator - List  

Web Studio: List Box 

Write Tag Write Tag

Search Tag or Read 
Tag

Read/Search Tag

Control Tag Control Enable

Block Write Start Tag Not Supported

Data Type/Format
Integer value, LSB and Single Bit are only modes 
supported.

Initial State Not Supported

Write Value On Enter Enter Required

Wrap List List Wrap

FG Color Border Color

BG Color Win Color

 States:

Number List Box State number or Error State

Message List Box Message

Access Not Supported 

Value Value

Text Properties
Alignment option not supported.  Text Foreground Color, 
Font and Size need to be the same for all states.
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PB Object: Graphic Indicator – Bar Graph  

SWS Object: Rectangle with Bargraph Dynamic + 
Rectangle with caption

Text Properties Rectangle Caption Properties 

FG Color Rectangle Liner Color

BG Color Rectangle Fill Color 

Read Tag Expression field of Bargraph Dynamic

Fill Bar Graph Dynamic Foreground Color

Blink Applied using a Color Dynamic with Blink Slow selected

Fill From
Direction and Orientation fields from the Bargraph 
Dynamic

Min/Max Range Min and Max values in the Bargraph Dynamic

PB Object: Graphic Indicator – Gauge  

SWS Object: Not Supported 

PB Object: Graphic Indicator – Scale Linear  

SWS Object: Set of lines that will represent the scale

Blink Position Dynamic with Blinkslow attached in each line

FG Color Used in the line colors

Tickmarks Import Wizard creates a line per each tick

PB Object: Graphic Indicator – Scale Circular 

SWS Object: Not Supported
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PB Object: Numeric Data Display

SWS Object: Rectangle

Text Properties Rectangle caption properties

Read Tag Used in the caption text between curly brackets

PB Object: Indicator – Message Display and Multistate Pushbutton  

SWS Object: Smart Message Object configured to message display

Read Tag Read Tag

Data Type/Format
Value property.  Real/Integer values, LSB and Single Bit 
are only modes supported.

 States:

Number Smart Message Number of Error State

Blink Rec Blink

Value Value

FG Color Rec (FG)

BG Color Rec (BG)

Graphic Graphic File

Text Properties
All the properties are supported.  Text Font and Size need 
to be the same for all states.

PB Object: Graphics - Line  

SWS Object: Line

Blink Implemented using Position Dynamic

FG Color Color
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There is no way to determine the direction of the line based on the report 
information, so the Import Wizard will always import the lines from down 
to up, left to right. In some cases the user will have to flip the lines after 
finishing the import. 



PB Object: Graphics – Connected Line and Free Form  

SWS Object: Not Supported 

PB Object: Graphics – Rectangle, Ellipse and Circle 

SWS Object: Rectangle, Ellipse and Circle 

BG Color Fill Color

FG Color Line Color

PB Object: Graphics – Graphic Image  

SWS Object: Bitmap 

BG Color Used to change the bitmap color when importing

FG Color Used to change the bitmap color when importing

PB Object: Text 

SWS Object: Rectangle with caption 

Text Properties Rectangle caption properties

Variables
All the variables are inserted in the caption using the 
Format function when format is necessary

 

PB Object: List Keys  

SWS Object: Not Supported

PB Object: Alarm List and Alarm Buttons 

SWS Object: Partially Supported, see note.
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automatically. The alarm buttons are not imported, but then can be easily inserted in the 
application by the user. 



Communication 

This release implements the most important communication drivers. However, some of the 
imported drivers have some differences due the way that Web Studio  treats the information. 
Most of the applications should not be affected by the differences, but in some cases small 
changes will be necessary. This section lists all the drivers supported by the Import Wizard and 
lists the limitations of each one. 

PanelBuilder Protocol: Modbus  
Web Studio Driver: MODBU 
- Signed and Unsigned variables will be imported as signed
- BCD Data Type is not supported 
- Char Array data types are not supported 
- Bit Arrays can only be used for readings

PanelBuilder Protocols: DH+/ DH485 / DF1 / DF1 -Ethernet 
Web Studio Drivers: ABKE, ABTCP and ABENI 
In order to communicate using DH+ or DH485 you will have to acquire a specific board for these 
protocols.  Please refer to Web Studio ABKE driver documentation for more information about 
the hardware that you will have to acquire. 

- Signed and Unsigned variables will be imported as signed; 
- Double words are not supported 
- It is not possible to have PLCs from different families in the same network 
- Bit Arrays can only be used for readings 
- Bit Arrays for counters and timers are not allowed
- PLC 5 addresses are imported using octal notation

 Note� : These drivers were tested against the following devices: PLC-5, SLC-500, Micrologix 
PLCs and Micrologix 1761-NET-ENI. According to the manufacturer documentation, the driver 
should workwith other devices. If you face any problem to establish communication with your 
device, please contact your SoftPLC representative. 

PanelBuilder Protocols: EthernetIP and ControlNet 
Web Studio Drivers: ABCIP 
The Import Wizard does not support the ControlNet network. When the ControlNet network is 
identified, the Import Wizard will convert all the tags using the ABCIP  driver for Ethernet. 
-Network path is not supported 

 Note� :  This driver was tested against the following devices: ControlLogix5000 and FlexLogix 
1761-NET-ENI. According to the manufacturer documentation, the driver should work with other 
devices. If you face any problem to stablish 
communication with your device, please contact your  representative. 
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http://softplc.com/products/migrations/hmi/
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Alarm Configuration 

Web Studio is very powerful and manages the whole alarm systemwithout any aditional PLC 
programming.  PanelBuilder, on the other hand, requires the alarms to be configured in the PLC 
and is only able to display the alarm messages and provide the acklowledgment feature.  
Migrating the whole PanelBuilder system to a Web Studio system using the PanelBuilder 
phiosophy would make applications as complex as they are in PanelBuilder. 

Therefore, the Import Wizard adopted a different approach.  It imports the information necessary 
to turn on the Web Studio alarm system and display all the alarm messages with Acklowledge 
capabilities. Depending on the PanelBuilder features that you are using on your application, you 
will have to perform some minor configurations in your imported application. You should read 
the next topics in order to understand how the Alarm Configuration is imported and which 
features are not imported automatically. 

Alarm Banner 

The current version does not import the Alarm Banner. The user needs to create a screen using 
the alarm object and name it Alarm_Banner. This screen will be automatically opened when an 
alarm is active.

 

Alarm Setup 

Banner Pop Up: Implemented automatically by Import Wizard selecting the alarm banner as 
Pop Up or Dialog 

Print Items:  Web Studio will print the alarms in the way that they are formated in the alarm 
object. You can customize the columns as well as the order in which the alarms will be printed. 
This powerful capability is imported in the alarm object that is inserted in your screen and you 
can customize it if you want. Because of this functionality we ignore the print items parameter. 

Ack Hold Time and Snapshot:  Industrial Alarm object is a scroll list with a lot of capabilities. 
These parameters are also not applied. 

Remote Ack and Use Optional Fields:  Web Studio supports remote acknowledgment by 
alarm message and by alarm group. PanelBuilder works very different and in some cases the 
user is required to associate bit off tags to acknowledge alarms.  If you are using this 
functionality you will have to implement some minor scripts using math. This parameter is 
ignored. 
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Alarm Triggers 

Trigger Tag: Tag used as base to generate the alarm messages inside the imported application. 

Trigger Type: The Import Wizard supports Bit and Value triggers. 

Ack, Remote and Handshake and Ack All:  When importing the alarm list the Import Wizard 
creates an Alarm Worksheet with all the alarm messages.  In order to implement these 
commands the user will have to implement some aditional configuration in the worksheet. 

Alarm Messages 

The Alarm Messages are implemented using auxiliar tags. The name of the auxiliar tags is 
formed using the formula [Trigger Tag]_Alr_[Value] where: 

Trigger Tag: Name of the tag used as trigger. 

Value: Value specified in the value colum. 

The auxiliar tags will have the alarm HI configured to 1 (one) with the PanelBuilder alarm 
message.  If the trigger is a Bit, the tag will be associated with the specific bit in the Driver 
Worksheet, otherwise it will be in a scheduler worksheet and it will go off when the trigger value 
assumes the value specified in the value column.  All the parameters available in the Alarm 
Messages configuration are available in Web Studio, but because the conception is completely 
different (PanelBuilder requires that the user configures colors per individual alarms instead of 
configuring per groups) they are not automatically imported. 

Security System 

The current version of Import Wizard does not import the security system automatically.  
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